Steampunk Cameo Necklace with OLED Display

Created by Leslie Birch

Last updated on 2018-11-10 04:00:33 AM UTC
## Guide Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guide Contents</td>
<td>2</td>
</tr>
<tr>
<td>Overview</td>
<td>3</td>
</tr>
<tr>
<td>Tools &amp; Supplies</td>
<td>4</td>
</tr>
<tr>
<td>Test OLED Display</td>
<td>6</td>
</tr>
<tr>
<td>Circuit Diagram</td>
<td>8</td>
</tr>
<tr>
<td>Solder Circuit</td>
<td>9</td>
</tr>
<tr>
<td>Bitmaps &amp; Code</td>
<td>14</td>
</tr>
<tr>
<td>Prepare Necklace</td>
<td>21</td>
</tr>
<tr>
<td>Finishing Touches</td>
<td>25</td>
</tr>
<tr>
<td>Wear it!</td>
<td>28</td>
</tr>
</tbody>
</table>

© Adafruit Industries

https://learn.adafruit.com/steampunk-cameo-necklace
Overview

This necklace uses an Adafruit Pro Trinket and an OLED screen to flash bitmaps of you and your loved one in between hearts. A tiny LiPoly battery powers the pendant discreetly in the black ribbon. Warning: Dog and cat pics may attract werewolves.
This is an intermediate level project that involves soldering, as well as some simple sewing skills. It’s always suggested to test your parts on a breadboard first. You’ll need:

- USB A/Micro B Cable (fabric one or regular fine) (http://adafru.it/2008)
- Monochrome 1.3” 128x64 OLED Graphic Display (http://adafru.it/938)
- Lithium Ion Polymer Battery 3.7v 100mAh (https://adafru.it/dAq)
- JST-PH Battery Ext. Cable (https://adafru.it/doS)
- Silicone Stranded Wire 30AWG Assorted (https://adafru.it/ekF)
- Breadboard (http://adafru.it/239) (helpful, but not required)
- Breadboard Wires (http://adafru.it/153) (helpful, but not required)
- Alligator Clips (http://adafru.it/1008) (helpful, but not required)
- Oval jewelry setting w/open back (check Art-i-Cake (https://adafru.it/eys) brand or steampunk section at craft store)
- Large jump ring (for ribbon)
- Small jump ring (for oval setting)
- Approx. 1.5 yards of 7/8” grosgrain ribbon
- A piece of adhesive felt to form a matte
- Wire Strippers (http://adafru.it/147)
- Flush Diagonal Cutters (http://adafru.it/152)
- Soldering Iron (small tip helpful)
- Drill (for creating mounting hole in pendant)
- Hot glue gun
- Scissors
- Rubbing alcohol
- Cotton swab
- Jewelry glue (metal to glass like Alene's)
- Thread to match ribbon color
● Sewing machine (or needle for hand sewing)

Make sure you get up-to-speed with these helpful guides:

● Introducing Pro Trinket (https://adafru.it/nXF)
● Monochrome OLED Breakouts (https://adafru.it/dAZ)
● Bonus: Adafruit GFX Graphics Library (https://adafru.it/doL)
Test OLED Display

It's always good to test your parts to be sure they are working correctly, and to get familiar with them. So, follow the directions on the Monochrome OLED Breakouts (https://adafruit.it/Cf6) learning guide under "Wiring 128x64 with SPI". I have headers soldered onto my parts to test them, as I start with a prototype. If you only have one set of parts, you'll want to put some test wires on your parts with a combo of alligator clips to get to your breadboard wires.

**OLED -> Pro Trinket**

- Gnd -> G
- Vin -> 5V
- Data -> Digital 9
- Clk -> Digital 10
- D/C -> Digital 11
- Rst -> Digital 13
- CS -> Digital 12

Make sure you have loaded the correct Pro Trinket Arduino software, as well as the drivers and libraries as outlined in the guides.

Now run:

File→Sketchbook→Libraries→Adafruit_SSD1306→SSD1306_128x64_spi

You'll know everything is okay if you got the Adafruit splash screen and a variety of examples like lines, circles, rectangles and other fun images. If your screen isn't powering up, double check the wiring and make sure your USB cable is tight in the Pro Trinket's connector. Okay, time to get building!
The circuit for the necklace will be done just as the wiring for the "Test OLED Display", except the JST battery extension cable will be added with its male end removed.

**OLED -> Pro Trinket**

- Gnd -> G
- Vin -> 5V
- Data -> Digital 9
- Clk -> Digital 10
- D/C -> Digital 11
- Rst -> Digital 13
- CS -> Digital 12

**JST Battery Cable -> Pro Trinket**

- Black wire -> G (solder it with the other OLED wire)
- Red wire -> BATT

---

No caffeine and make sure you read the "Solder Circuit" section first!
Solder Circuit

Start by measuring and cutting all wires needed. It's good to keep them short since parts will be stacked. Remember, the Pro Trinket will be on the back of the OLED with the majority of holes being in close proximity. Allow extra room when you strip the wire ends so you will have adjustment room. You can always trim the excess off after soldering.

Prepare the JST connector cable by trimming off the male end of the connector. It won't be needed since you will be wiring directly to the Pro Trinket. Split the red and black wires for a short distance and then strip the ends so they are ready to go.
Okay, solder time. Make sure you tin your wires as you go. First solder wires on the Pro Trinket, remembering they will reach straight down to meet the back side of the OLED. It helps to use a third hand tool or vice. Remember to allow for two wires to be soldered together into the G (ground) on Pro Trinket.
Now, gather your patience. You will need to line up the wires from the Pro Trinket with the holes of the OLED. You want the Pro Trinket board's top and bottom edges to line up with the edges of the OLED, so the holes will not line up perfectly, but they will be close. This will require the use of a third hand tool, vise and tweezers. If you can't get them all to line up at once, then just work by soldering one wire at a time.
Once the solder cools, trim excess wire tips. Also, use a hot glue gun and add a pillow of glue inside the bottom edge of the Trinket. It should fall right below the reset button. Quickly push the Trinket against the glue. This will help support your cameo sandwich. While you are at it, swirl your battery wires against the right side of the OLED board near the Trinket and glue them in place for strain relief.
Bitmaps & Code

Time to create two image files and convert them into a code the OLED can understand.

1. Use Photoshop or another imaging program to create two cameo profile pics and turn them into bitmaps (.bmp). They should be monologue and 128x64 pixels. Notice I had my images each facing another direction.
2. Download [LCD Image Converter](https://adafru.it/eyx) and run.
3. Choose **New Image** and create a name. Then hit enter.
4. Now choose **Image** and **Import**. Select the file.
5. Now choose **Options** and **Conversion**, then **Prepare**. The following should be checked: Type: **Monochrome**, **Threshold Dither**, Main Scan Direction: **Left to Right**, Line Scan Direction: **Forward**
6. Now select **Image**. Make sure **Select to Rows** is checked. **8-Bit** and **Little Endian**.
7. Hit **OK**, then **File**, **Convert**. Name the file. Now do the same process for your other file. The completed files will contain a series of code that you need to cut and paste into the project code to replace the files I provided. It will look something like this, only longer. Note that you don't need the beginning name, just the brackets and what is contained within them:

```c
static const uint8_t image_data_LesInv[1024] = {
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00}
```

Okay, time to cut and paste the code for the Arduino program to run the necklace. Don't forget to replace the two areas of code with your new code from your image files. Go ahead and upload!
```c
#include <SPI.h>
#include <Wire.h>
#include <Adafruit_GFX.h>
#include <Adafruit_SSD1306.h>

#define OLED_MOSI   9
#define OLED_CLK   10
#define OLED_DC    11
#define OLED_CS    12
#define OLED_RESET 13
Adafruit_SSD1306 display(128, 64, OLED_MOSI, OLED_CLK, OLED_DC, OLED_RESET, OLED_CS);

// Uncomment this block to use hardware SPI
#define OLED_DC     6
#define OLED_CS     7
#define OLED_RESET  8
Adafruit_SSD1306 display(128, 64, &SPI, OLED_DC, OLED_RESET, OLED_CS);

static const unsigned char PROGMEM cameo16_glcd_bmp[] =
{
  // Define image data for Cameo16
};
```
static const unsigned char PROGMEM cameo19_glcd_bmp[] =
{
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x3e, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x7f, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x3f, 0xff, 0xff, 0xff, 0xff, 0xff,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x7f, 0xff, 0xff, 0xff, 0xff, 0xff, 0xff, 0xff, 0xff, 0xff, 0xff, 0xff,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
  0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
void setup() {
    Serial.begin(9600);

    // SSD1306_SWITCHCAPVCC = generate display voltage from 3.3V internally
    display.begin(SSD1306_SWITCHCAPVCC);
    // init done

    // Show initial display buffer contents on the screen --
    // the library initializes this with an Adafruit splash screen.
    display.display();
    delay(2000); // Pause for 2 seconds

    // Clear the buffer.
    display.clearDisplay();
}

void loop() {
    // First two numbers in each drawBitmap() call are the top-left pixel
    // coordinate, next three are the logo name, width, height and rotation.
    display.clearDisplay();
    display.drawBitmap(0, 0, cameo16_glcd_bmp, 128, 64, 1);
    display.display();
    delay(8000);

    display.clearDisplay();
    display.drawBitmap(0, 0, cameo17_glcd_bmp, 128, 64, 1);
    display.display();
    delay(8000);

    display.clearDisplay();
    display.drawBitmap(0, 0, cameo18_glcd_bmp, 128, 64, 1);
    display.display();
    delay(8000);

    display.clearDisplay();
    display.drawBitmap(0, 0, cameo19_glcd_bmp, 128, 64, 1);
    display.display();
    delay(8000);
}
Prepare Necklace

First, if your setting was oriented horizontally, gently remove the jumper ring. We'll be using it later. Then, examine your jewelry setting and see how the current ornament is attached. Most likely you will need to swab the glued area with alcohol on the back. Let it sit for 10 minutes and then push from behind to release the ornament.
Next, clean any residue from the ornament. You may want to use a combination of hot sudsy water, as well as alcohol. When that is done, drill a hole into the new location you want your jump ring. Mine is placed at the top of the oval.
You will need to fill in the oval ring with a matte. So, hold up your illuminated OLED into the setting so you know how thick your matte needs to be to hide the edges of the screen. Then, use an image program to draw an oval that meets the measurements needed. Trace the pattern onto the back of the adhesive felt backing and cut with sharp scissors. Then, peel off the backing and apply to the inside of the setting.
Time to mount the OLED. Peel off the protective film and double check how it appears while illuminated in the setting. Notice the glass plate is not centered on the PCB, so make sure you view it from the side that will be seen when positioning it. Apply a small drop of jewelry glue on each corner of the actual glass plate on the OLED (not the PCB) and press firmly onto the setting.

Jewelry glue is toxic, so be sure to wear gloves. It also sets quickly.
Finishing Touches

Take the small jump ring you set aside earlier and use it to attach the large jump ring to the top of the pendant.

Take the yard of black ribbon and hold it around your neck to find the right length, allowing ends to tie. Then, cut the appropriate piece and tie the center of it once around the large jump ring.
Use the second piece of ribbon to create two channels for the JST cable and battery. These channels will be stitched on the underside of the ribbon opposite from the JST wires coming from the Trinket. The opening between the two channels will be the place for the connectors to lock. Stitch both channels right next to the edges of the ribbon. Top stitch the other ribbon without channels to match.

Tie the JST cable coming from the Trinket around the large jump ring as strain relief. Then, feed it into the channel in the ribbon. Cut a small piece of extra black ribbon and tie it around the JST cable that peeks through the jump ring, to cover it.
Wrap the top of your battery and part of the wires with tape as strain relief. I've used gaff tape, but masking tape is also fine.
Insert the battery up into the top channel so its connector just peeks out of the end of the channel. Connect it to the JST cable connector that should also just be visible in the other channel. Now, tuck the connectors in so they aren't visible. Then, tie the necklace around your neck and get ready for some late night fun. The battery will last 3.5 hours, so be ready to tell your vampire when to leave.